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Directory Paths Used in Labs
The following directories will be referred to often in the labs.  To simplify lab 
instructions there are many places where the variables listed below will be used in place 
of the actual directory path.

Some directories which should already exist before you start the labs are listed below 
with values.  Please verify the location of these directories matches what is listed here 
and make a note of the change if it does not.  Also notify your instructor if anything does 
not match.

Some directories will not yet exist as you will be installing software in the labs.  These 
are listed here so you can write down the appropriate directory here when installing the 
software.

Directories that should exist already:

<WESB_SOFTWARE_DIR>:  C:\Software\ESB62

<LABFILES_DIR>:  C:\LabFiles

<DB2_ROOT>:  C:\Program Files\IBM\SQLLIB

Directories created during labs:

<WESB_ROOT>:                                                                                  
<DM_PROFILE_ROOT>:                                                                  
<CSTM_PROFILE_ROOT>:    ___________                 
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Note: Hostnames Used in Labs
The following computer hostnames will be referred to often in the labs.  To simplify lab 
instructions there are many places where the variables listed below will be used in place 
of the actual directory path.

In most cases, all the hostnames will refer to the same physical computer (localhost); the 
one you are performing these lab exercises on.  However, in a production environment, 
that would rarely be the case.  For example, in a production environment, you might have 
separate physical machines for the database server, the web server, and multiple WESB 
servers. 

In order to keep things clear, during the lab exercises we will specify hostnames using 
variables.  For example, <DB_HOSTNAME> will be used to refer to the machine where 
the database is running.

The major hostnames we will use are:

<WESB_HOSTNAME> - the machine where we will run the deployment manager and 
server instances.

<DB_HOSTNAME> - the machine where we will run the database.

<WEBSERVER_HOSTNAME> - the machine where we will run the web server.

For the purposes of these exercises, most of the time, you will substitute these hostnames 
with localhost.  If, however, you decide to use separate machines when doing these labs 
in a different environment, replace accordingly.  
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Lab 1 - Installing  WebSphere ESB
In this lab, you will install WebSphere Enterprise  Service Bus v6.2 (WESB).  WESB 
is built on top of WebSphere Application Server, Network Deployment (WAS ND) 
edition v6.1, so when you install WESB, you're really installing WAS ND too.  

WESB relies on TCP/IP networking.  It is important to have networking correctly 
configured before starting the installation and the host name must remain fixed.  Your lab 
machine should be configured correctly for the lab.  

A Windows user, who belongs to the Administrators group, has already been created for 
you.  You should use this user to log in to Windows and install WESB

User id:  wasadmin

Password:  wasadmin

Note that we will be using a different set of user ids and passwords to configure WESB 
and DB2 in the next lab.

Following this exercise, you should be able to:

● Install WESB

● Examine the installation and learn how to check the version of WESB

Part 1 - Install the Software
Make sure that you are logged in as the administrative user listed above.  If you are not, 
log off and log back on as the user wasadmin above.

If possible, disable any anti-virus or script-blocking software that may interfere with the 
installation.

__1. Open a Windows Explorer window.

__2. Navigate to the <WESB_SOFTWARE_DIR>\ directory substituting the value of 
the <WESB_SOFTWARE_DIR> variable with the location mentioned in the list of 
directory paths at the beginning of these labs.  Check with your instructor if you can't find 
the directory listed.

__3. Double click on the launchpad.exe file to run it.

The launchpad program will launch.
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__4. Click the link labeled IBM WebSphere ESB installation.

__5. Click the link for Launch the installation wizard for WebSphere ESB.

The setup wizard will begin.

__6. Click Next.

__7. The Software License Agreement screen will appear.  Select I accept both the IBM 
and the non-IBM terms and click Next.

__8. The System Prerequisites Check screen will appear.  You should see a Passed 
message.  If you do not, contact your instructor immediately.
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__9. Click Next.

The WebSphere Enterprise Service Bus Installation Type Selection screen will appear. 

__10. Leave Typical Installation selected. 

(This Typical Installation will allow us to defer the creation of a deployment environment 
(i.e. an actual server environment) until a later time.  We will create the deployment 
environment in the next lab exercise.   Selecting Deployment Environment here would 
force us to create one right away, which we do not want)

__11. Click Next.

The Features Selection  screen will appear.
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__12. Make sure the box for WebSphere Enterprise Service Bus Samples is left 
unchecked.

The sample applications are unnecessary and will just slow down server install and boot 
processes. 

__13. Click Next.

The Installation Root Directory for WebSphere Enterprise Service Bus screen will appear. 

__14. Change it to C:\IBM\WebSphere\ESB 

The default  (with \Program Files\ in the path) is a little on the long side – and IBM 
software running on the Windows platform has occasionally had problems with path 
names over 256 characters.  Adding “Program Files” does not help.  

__15. Write down this installation directory as the value of the <WESB_ROOT> 
variable in the list of directory paths at the beginning of these labs.

__16. Click Next.

The WebSphere Enterprise Service Bus Environments  screen will appear. 

__17. Select None.

As mentioned earlier, we will create our own profile in the following lab. 
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__18. Click Next.

A warning screen will appear.  

__19. Click Yes.

The Installation Summary screen will appear. 
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__20. Click Next.

The installation process will begin.  This will take a while (anywhere from 20 – 40 
minutes)

Eventually, the install will complete. 
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__21. Click Finish.

The Profile Management Tool will launch.

We will use this tool in a later lab.    For now, just click Cancel.

__22. Close the Launchpad program.  We no longer need it. 

Congratulations!  You have installed WESB. 

Part 2 - Examine the Installation
In this part, you will examine the software that was installed, including some of the 
directories and the software versions.
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First, inspect the installation log files. They come handy resolving installation problems.

__1. Using file explorer, go to <WESB_ROOT>\logs\install folder.

__2. Open log.txt using wordpad. The very last line should say:

com.ibm.ws.install.ni.ismp.actions.ISMPLogSuccessMessageAction, msg1, 
INSTCONFSUCCESS

Next, we will look at the Start menu entries.

__3. Click Start > All Programs > IBM WebSphere and you will see two shortcuts 
listed underneath:  Application Server Network Deployment v6.1, and Enterprise 
Service Bus 6.2

__4. Also, notice that the shortcuts listed underneath Application Server Network 
Deployment v6.1 and Enterprise Service Bus 6.2 are almost identical.

__5. Next, we will view the version information of the installed products. Open a 
command prompt  window.  You can do this by selecting Start-> Run, entering cmd and 
then pressing OK.  

__6. Change directories using the cd command to the <WESB_ROOT>\bin directory. 

Be sure to substitute the value of <WESB_ROOT> from the "Directory Paths" page at 
the beginning of the lab instructions.

__7. Enter the command 

versionInfo

The following will appear:
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This command is useful if you need to confirm whether or not a fix pack or refresh pack 
from IBM has been applied.  Notice the following:

• The version of WAS ND is 6.1.0.21.

• The version of WebSphere Enterprise Service Bus is 6.2.0.0.  (This implies no fix 
packs or refresh packs have been applied to WESB.)
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__8. Last but not least, open a Windows Explorer window.

__9. Navigate to the <WESB_ROOT> directory you wrote down in the notes at the 
beginning of these labs.  This serves as the main installation directory for WESB

Note there is no separate directory for WAS ND, which explains why most of the 
directories are identical to the ones you'd find in a WAS ND installation.

 Some new directories introduced in the mix include:

● uninstall.wbi – contains an executable used to uninstall WESB and optionally 
WAS ND

● universalDriver_wbi – contains the WESB embedded DB2 Universal JDBC 
driver.  We will be refering to this directory multiple times as we will be using 
these drivers to connect to DB2. 

__10. Close all open windows.

Part 3 - Review
In this lab, you installed WESB.  You also examined some of the artifacts of the 
installation process and learned how to check the version of the software.
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Lab 2 - Configuring the Deployment Manager
In this lab, you will begin the task of configuring WebSphere Enterprise Service Bus 
(WESB).  Getting a full “servable” WESB environment up and running is a complex 
process and involves many steps, which we will not attempt to complete in one lab.  In 
real life, however, you will probably choose to do everything at once.  

The goal of this lab is to configure a network deployment environment, consisting of a 
deployment manager. This implies creating a profile which will host the deployment 
manager.  Note that this profile cannot be used to host applications, but rather to manage 
a deployment environment. In a later lab, we will create the deployment environment 
which will be the actual server environment that will host ESB applications.

WebSphere Enterprise Service Bus (WESB) is built atop WebSphere Application Server, 
Network Deployment (WAS ND).  WESB is made up of a number of components.  These 
components use a number of different databases to store and keep track of information.

Component Database
Suggested 

Name Description

Relationships

Mediation

Recovery

Application 
Scheduler

Selectors/ 
Business Rules

Common WPRCSDB It's recommended to create this 
database before profile creation.  The 
tables themselves will get created after 
profile creation. Should exist before 
the deployment manager can be started 
with no errors.

SIBus Message Bus 
(a.k.a. 
Messaging 
Engine)

MEDB Used by the service integration bus 
(SIB) messaging engines to store 
information, such as persistent 
messages and transaction states.  The 
Service Component Architecture 
(SCA) and Common Event 
Infrastructure (CEI) each have their 
own buses.  It's recommended that 
they share the same database.

Enterprise 
Service Bus

Enterprise 
Service Bus 
Logger 
Mediation

WPRCSDB Used by mediation modules to log 
messages, specifically by the 
MessageLogger mediation primitive.

Common Event Common Event EVENT Used to capture WebSphere Process 
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Infrastructure Infrastructure Server events.  (Every server or cluster 
must have its own database.)

As you can see from this table, we will eventually need 3 databases.   WPRCSDB, 
MEDB and EVENT.    However, for the purposes of this lab (setting up the deployment 
manager profile) we will only need the WPRSCDB database.  We will configure that later 
in this lab. 

In this lab, we will accomplish two basic tasks:

• Create the deployment manager profile

• Configure the required WPRCSDB (Common) database

Part 1 - Create the Deployment Manager Profile
The first step is to create the Deployment Manager profile.  Remember that in a later lab 
we will be creating a deployment environment in the profile we are creating here, and it is 
that deployment environment that will be used to host applications. 

__1. From the Start menu, select All Programs | IBM WebSphere | Enterprise Service 
Bus 6.2 | Profile Management Tool.

Note

Alternatively, you can change to the <WESB_ROOT>\bin\ProfileManagement\ 
directory and run pmt.bat

The Profile Management Tool will launch.

__2. Click Next.

The Environment Selection screen will appear.  
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Note

In addition to creating brand new WESB profiles, you have the ability to augment, or 
add WESB capabilities to an existing WAS 6.1 or WAS ND 6.1 profile.  This is because 
WESB is built on top of WAS ND, which is built on top of WAS.

__3. Select WebSphere Enterprise Service Bus as shown above and click Next.

The Profile Type Selection screen will appear.

We now specify that we want to create a new deployment manager profile.  Later, when 
we deal with the actual deployment environment, we will create a custom profile. 

Note

A Deployment Manager profile, like a Network Deployment Deployment Manager 
profile, creates a cell, a deployment manager node, and a deployment manager server 
that's used to administer application servers running on nodes that are federated into it. 
In addition, it's used to federate process servers (really specialized application servers) 
that are federated into it.

__4. Select Deployment manager profile.

__5. Click Next.

The Profile Creation Options screen will appear.
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We will not want to use the defaults provided by a Typical profile creation, so we will go 
with the Advanced approach.

__6. Select Advanced Profile Creation.

__7. Click Next.

The Optional Application Deployment screen will appear.

__8. Leave the box checked and click Next.

The Profile Name and Location screen will appear.  
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We will use these default values. Note that the profile name for this deployment manager 
profile will be Dmgr01. 

Also note that the profile directory is C:\IBM\WebSphere\ESB\profiles\Dmgr01

__9. This path will be referred to as <DM_PROFILE_ROOT> throughout these labs; 
record this name in the Directory Path table in the first page of these lab exercises.

__10. Accept the defaults and click Next.

The Node, Host and Cell Names screen will appear. 
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These follow standard WAS naming conventions.  Note that the Host name should be the 
same as your computer's hostname.  (In the screenshots shown in these examples, the 
host name was WAxxxx).  The node and cell names are generated accordingly. 

Warning: Do not set the hostname to WAxxxx. That is just a sample and the hostname 
of the machine where this lab was developed. Enter the hostname of your own machine 
here.

__11. Accept these defaults and click Next.

The Administrative Security screen will appear.  Here, we specify the administrative user 
name and password for the deployment manager environment.  This will be the overall 
“administrative” user. 

__12. Set the User name to wasadmin

__13. Set the Password and Confirm password to wasadmin

__14. Click Next.

The Port Values Assignment screen will appear. 

__15. Accept the defaults and click Next.

The Windows Service Definition screen will appear. 

__16. Uncheck the box marked Run the deployment manager as a Windows service.
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__17. Click Next.

The Database Configuration screen will appear. 

As mentioned earlier, the deployment manager for an ESB requires a database to operate; 
this database is the common database, also known as WPRCSDB.

What we are specifying here is the type of database to use, and the name.  We want a DB/
2 database, and we will use the default name WPRCSDB.

__18. Change the Choose a database product dropdown to DB2 Universal.

The default setting (Derby) is merely a sample database that is included with WESB and 
is not useable in production. 

__19. Check the box marked Delay execution of database scripts.

When this profile is created, some scripts will be generated and placed in the profile 
directory.  Typically, a  DBA would  then take those scripts and run them on the 
<DB_HOST> machine to create the required database resources (tables, etc)

If we checked this box, that script execution would occur automatically.   However, this is 
not typically done. We will manually run these generated  scripts ourselves later to 
simulate a DBA doing their part. 

Realize that all we are doing is pointing to a database named WPRCSDB which does not 
actually exist yet.  This process will not actually create the required database/tables.  You 
will create the database using the generated scripts later in this lab exercise. 

__20. Click Next.

The Database Configuration (Part 2) screen will appear. 
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This is the information that the deployment manager will use to attempt to access the 
WPRCSDB. 

__21. Set the User name, Password and Confirm password fields to db2admin

DB/2 has already been pre-installed on your computer, and db2admin is a user defined 
there.  It is important to note that db2admin has database/table creation privileges.  

Note the Database server host name field.  Here, you would enter the 
<DB_HOSTNAME>.  For these lab exercises, you will just specify  your local 
machine's hostname (which should be already be specified in the field by default).

Also note that you can specify the location of the drivers for connecting to DB/2.  By 
default, the drivers that ship with WESB are used.

__22. Click Next.

The Profile Creation Summary screen will appear. 
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__23. Click Create.

The profile will be created.  This will take a few minutes.  

Eventually, it will complete. 

__24. Uncheck the box Launch the First steps console and click Finish.

The Deployment Manager profile has now been created!

Part 2 - Create the WPRCSDB Common Database
As mentioned above, the deployment manager in a WESB environment requires a 
database, known as the Common DB, to operate. During the the previous lab part, you 
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configured the deployment manager to use a database called WPRCSDB as this Common 
DB, but did not actually create the required database and tables.  We will do so now.

Creating the tables involves executing scripts that were generated by the Profile 
Management Tool at profile creation time.  They can be found in the profile directory.

__1. Open a command prompt window.

__2. In the command prompt window, cd to 
<DM_PROFILE_ROOT>\dbscripts\CommonDB\DB2\WPRCSDB

__3. Enter the following command:

db2cmd createDBTables.bat db2admin WPRCSDB createDB 

A new DB2 CLP window will open, and the script will execute. 

__4. After a few moments, you will be prompted for a password. Enter db2admin

Type carefully as the window will not echo your characters! 

This script will create the WPRSCDB database, as well as all the required tables. When it 
is done, the window will simply exit.  

We should now verify that the tables were created correctly. 

__5. In the same command prompt window, enter the command db2cmd

__6. A new command window will open.  In that window, enter the command:

db2 connect to WPRCSDB

This connects us to the database that we just created.  If this worked successfully, it 
means the database was indeed created successfully.  We should now check to see if the 
tables were correctly created.  

__7. Enter the command:

db2 list tables for schema db2admin

A list of 23 tables should appear. 
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The Common DB has been successfully created! 

__8. Close all command prompt windows.

Part 3 - Start the Deployment Manager
We will now start the deployment manager to make sure creation was successful.  It is 
possible to start the deployment manager through various means such as short cuts (off 
the Start menu) and the First Steps launcher; however, here we will use the preferred 
approach which is the command line.

__1. Open a command prompt window and cd to  <DM_PROFILE_ROOT>\bin

__2. There, enter the command 

startManager.bat

__3. The deployment manager will boot.  Wait until you see the following message:
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The “open for e-business” is typically a sign that the server has started successfully. 
Memorize these steps for starting the deployment manager as you will be using it again 
throughout the course.

Leave the command prompt window open as you will need it again later in this lab.

Let us see if we can login to the admin console.  

__4. Open a web browser, and navigate to:

http://localhost:9060/ibm/console

Your browser throw a warning about an untrusted certificate or any kind of security alert. 
Ignore the warning and proceed  (for example, on Internet Explorer, simply click Yes to 
proceed.)

A login screen will appear.

__5. Enter wasadmin for the username and password and click Log in.

The admin console will appear.  This is where you will be doing the bulk of your 
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administration over the following labs. 

This is the same URL that you use to access the Administrative Console for WAS ND, 
which makes sense, since WESB is built on top of WAS ND.  

You may notice:

• In the About your WebSphere Process Server box, the version of WPS is listed. 
Also, if you scroll down, the version of WAS ND is listed.

• There's an extra group in the Navigation tree (in the left pane) called Integration 
Applications, which we will access later.

__6. Using your browser, bookmark this link, as you will be continually logging into the 
admin console throughout these exercises.

Our deployment manager profile has been successfully created and is working fine!

__7. Logout of the admin console, by clicking the Logout link in the top right corner of 
the admin console.

__8. Close the browser.

Part 4 - Backup the Configuration
We will now make a backup of the configuration.  Make a habit of doing so on a regular 
basis; that way, in the event of a failure, you can always restore the configuration.

__1. At the command prompt, from the profile's bin directory, enter the following 
command:

backupConfig PostProfileCreation.zip
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The command will execute. 

__2. A Login at the Target Server screen will appear.  Enter wasadmin for the User 
Identity and User Password.

This happens because in order for a backup to proceed, the deployment manager must be 
stopped, and stopping the deployment manager requires user name/password 
authentication.

The script will continue execution. The deployment manager will be stopped, and the 
backup file will be created.

Notes: 

To restore the configuration, you use the restoreConfig command. 

After the backup is complete the Deployment manager is stopped.

28

EVALUATIO
N O

NLY



Congratulations!  You have successfully created a backup of the deployment manager 
profile.

Part 5 - Review
In this lab, you:

• Created the common database that the deployment manager profile will use

• Created the deployment manager profile Dmgr01

• Started the deployment manager to make sure it worked

• Logged onto the admin console

• Made a backup of the deployment manager profile.
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Lab 3 - Creating the Deployment Environment
In this exercise, you will create the deployment environment.  So far, you have defined a 
deployment manager profile which can administer an ESB environment; however, you 
have not yet defined any actual servers that are capable of hosting ESB applications.   

In this lab, you will build a deployment environment consisting of a cluster hosting a 
single server instance. This will allow you to run our ESB applications. 

In order to do this, the steps that need to be taken are:

• Create a Custom Profile

• From the deployment manager admin console, create a deployment environment 
using the provided wizard.  This deployment environment will consist of a cluster 
containing a single server. 

• Create the required MEDB and EVENT databases

At the end of this lab, your architecture will look like the following:
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Part 1 - Create the Custom Profile
A profile will be needed to host the server.  This is the server that will host ESB 
applications. We will use a custom profile for this.  A custom profile simply defines a 
node, but with no servers.  The server will be added later, by the deployment environment 
wizard. 

We will create the custom profile using the Profile Management Tool. 

__1. Start the Deployment Manager if it is not already running.  To check this, try 
logging into the admin console.  If you cannot, start the deployment manager first.  Make 
sure the deployment manager is running before continuing these steps.

__2. From the Start menu, select All Programs > IBM WebSphere > Enterprise 
Service Bus 6.2 > Profile Management Tool.

The Profile Management Tool will launch.

__3. Click Create.

__4. On the Important information for Version 6.1  screen, click Next.

The Environment Selection screen will appear.  

__5. Select WebSphere Enterprise Service Bus.
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__6.  Click Next.

The Profile Type Selection screen will appear.

__7.  Select Custom profile.

__8. Click Next.

The Profile Creation Options screen will appear. 

__9. Select Advanced profile creation.

__10. Click Next.

The Profile Name and Location screen will appear. 
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Note that the profile name is Custom01.  Also note that the profile directory will is 
C:\IBM\WebSphere\ESB\profiles\Custom01.  Record this as the value of 
<CSTM_PROFILE_ROOT> in the listing of directory paths at the start of this lab 
guide. 

__11. Accept the defaults and click Next.

The Node and Host Names screen will appear. 

Your machine's host name will be shown, and the node name will be generated 
accordingly. 

__12. Click Next.

The Federation screen will appear.  As soon as the profile is created, it will attempt to 
join a cell; in our case, we want it to join the cell we created in the previous lab.  This is 
why the the deployment manager was started at the beginning of this lab. 
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Note that the settings here already point at the deployment manager (server localhost on 
port 8879).   Naturally, if the deployment manager was running on a different 
machine/port, those details would be placed here instead. 

We just need to specify the DM's username and password to authenticate the federation 
process.

__13. Set the  User name and Password to wasadmin

__14. Click Next.

The Port Values Assignment screen will appear. 
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Realize that these port numbers are for the node agent that will run out of this profile.

__15. Accept the defaults and click Next.

The Database Configuration screen will appear. 

__16. Change the drop-down to DB2 Universal.

__17. Click Next.

As with the deployment manager, this node will need access to the CommonDB 
(WPRCSDB) and so it needs database connection information. 

The Profile Creation Summary screen will open.

__18. Click Create.

The profile will be created.  Wait patiently.
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Eventually, the profile creation will complete.  

__19. Uncheck the box marked Launch the First steps console and click Finish.

__20. Close the Profile Management Tool.

The profile has been created!

Next, we need to create a database that is required for ESB (with SCA enabled) to run.

Part 2 - Create the MEDB database
One of the databases that our ESB cluster will need is the MEDB database.  We will 
create this table manually, and then manually create the required tables in the database by 
running some ESB provided scripts. 

ESB provides a script which itself generates a script which can be used to create the 
tables.  This generated script would often be given to a DBA to create the tables (as it is 
possible that a DBA may be hesitant to give access to a WebSphere admin); in our case, 
we will act as the DBA.  So, we will first run the script that generates the database 
creation scripts – and then we will run those generated scripts.  

__1. Open a new command prompt window.

__2. In the new window, cd to <WESB_ROOT>\bin

__3. Enter the command:

SibDDLGenerator -system db2 -platform windows -schema WPRSS00 -user 
db2admin -create -statementend ; >> C:\createSYSCON.ddl

The script should execute without any problems.  A new file C:\createSYSCON.ddl will 
be created.  

__4. Now, enter the command:

SibDDLGenerator -system db2 -platform windows -schema WPRSA00 -user 
db2admin -create  -statementend ; >> C:\createSYSAPP.ddl
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The script should execute without any problems.  A new file C:\createSYSAPP.ddl will 
be created.  

We now need to execute the two scripts that have been created. Those scripts, however, 
will only create the tables.  We need to manually create the database. 

__5. In the command window, enter db2cmd

__6. A new command window will open.  In that one, enter the command 

db2 create db MEDB

This creates the database.  

Now we can run the scripts to create the required tables.

__7. Now, enter the following :

db2 connect to MEDB

__8. Now, enter:

db2 -tf C:\createSYSAPP.ddl
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__9. Next, enter:

db2 -tf C:\createSYSCON.ddl

Both scripts should run without any problems.  You should see a collection of “The SQL 
command completed successfully” statements.

The MEDB database has been configured successfully! 

Note

Earlier, we specified that we would need two databases: MEDB and EVENT (in 
addition to the already created WPRCSDB).  In this part of the lab, we created the 
MEDB database. 

This just leaves the EVENT database.  We will do that after the deployment 
environment has been created.  This is because the deployment environment creation 
process actually generates scripts that we can use to create/configure the EVENT 
database.

__10. Close all command prompt windows.

Part 3 - Verify Node Federation
At the end of profile creation, the newly created node should have been federated to the 
deployment manager's cell. We will now verify that.

__1. Login to the admin console:

http://localhost:9060/ibm/console

__2. On the left hand navigation bar expand System administration and click Nodes.

__3. Verify that two nodes are displayed – one for the deployment manager and the other 
where applications will be hosted.

Part 4 - Create the Deployment Environment 
We will now create the deployment environment.  A deployment environment is a 
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collection of servers, cluster, Service Integration Bus required for one to start deploying 
applications. You can create these components individually, but the creation of a 
deployment environment greatly simplifies the task.  Once we have defined a deployment 
environment, we will be able to deploy and test an ESB application (which we will do in 
the next lab).

__1. In the left pane of admin console, expand Servers and click Deployment 
Environments.

__2. In the right pane, click New.

__3. Set the Deployment environment name to MyTopology

__4. Click Next.

You will then shown a list of available deployment environment patterns.
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These reflect the various topology patterns that are available to ESB administrators.  Each 
one offers different levels of redundancy and complexity.  We will keep things simple for 
these labs; the topology we will create is shown in the diagram at the start of this lab 
exercise.  A single cluster with a single server; the entire cluster will all share the same 
resources (messaging engines, databases, etc)

__5. Select Single Cluster and click Next.

The Select Nodes screen will appear, listing all the nodes that can participate in the 
cluster. It should list the node matching the custom profile we created earlier in this lab.

If you had created more nodes and federated them with this deployment manager, they 
would be displayed here.  

__6. Select the node by checking its box and click Next.

__7. On the Clusters screen, click Next.

__8. On the System REST Service Endpoints screen, click Next.

The Database screen will appear.
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ESB makes use of these databases to store information for various features.  Note that at 
the moment, they all go to the same database (WPRSCDB) which is the CommonDB that 
we created in Lab 2.  While there is nothing wrong with this, we will actually use 
separate database instances to store the various data required.  This allows for cleaner 
data partitioning.

This list of 5 items can actually be divided into three groups: the CEI database, the SCA 
database, and the Business Space database.  We will create  two of the databases 
manually and refer to them from here.

__9. For the first two items on the list (Common Event Infrastructure), set the Database 
Instance to EVENT

__10. For the next two items (Service Component Architecture), set the Database 
Instance to MEDB

__11. Uncheck all the Create Tables boxes.  We have already created the tables for the 
MEDB database, and we will manually create the tables for the EVENT database 
afterwards.

The table should now look like the following:
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__12. Click Next.

__13. On the Security screen, click Next.

__14. On the Summary screen, click Finish and Generate Environment.

The environment will be generated.  This will take a few moments  Eventually, it will 
complete and you will see the following.

__15. Click Save Changes. (second button)

A list of Deployment Environments will appear. 
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Our deployment environment has been created!

These steps will have created a cluster containing a single server.  Let us see these. 

__16. In the left pane, expand Servers and click on Clusters.  The right pane will show a 
table of defined clusters.  You should see the one that was just created: 
MyTopology.AppTarget

__17. In the table click MyTopology.AppTarget

Details of the cluster will be displayed in the right pane.  Let us see what servers belong 
to it. 

__18. On the right, under Additional Properties, expand Cluster members.

You should see a member named like the following: 
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That member is an application server instance that belong to this cluster.

So, our deployment environment has been created for us!

__19. Logout of the admin console and close the browser.

Part 5 - Complete Configuring the EVENT Database
Recall that earlier in this lab exercise, we created the EVENT database, but did not create 
the tables required for it.  We will do that now. 

Running the deployment environment wizard actually created the scripts for us.  All we 
have to do is execute them. 

__1. Open a new command prompt window.

__2. In the command prompt window, cd to 
<DM_PROFILE_ROOT>\databases\event\MyTopology.AppTarget\dbscripts\db2

This folder contains the scripts that were just created. 

__3. Enter the command:

cr_event_db2.bat server db2admin db2admin

The script will execute.  It should execute without any problems. 

The EVENT database has been created and configured! 
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Part 6 - Fixing CEI
Unfortunately, there appears to be a bug in WESB 6.2 where configuration of the 
Common Event Infrastructure is not happening as it should.  In the preceding steps where 
you created a deployment environment, CEI configuration should have completed 
automatically.  That is not the case.  We have to make one minor fix before CEI is active.

__1. Logon to the admin console. 

__2. In the left pane, expand Servers and click on Clusters.  The Server Clusters table 
will appear on the right.

__3. Click the link for our cluster. (MyTopology.AppTarget)

__4. On the right, under Business Integration, expand Common Event Infrastructure.

__5. Click Common Event Infrastructure Server.

The Common Event Infrastructure Server screen will appear. 
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__6. Under Common Event Infrastructure Bus Member,  (which is the lower box) click 
Test Connection.

A failure message will appear. 

This is a symptom of the bug.  What has happened is that when attempting to connect to 
the EVENT database (which is used by CEI to store messages) the authentication 
mechanism does not appear to be submitting the relevant data to the database (hence the 
error message “Null userid is not supported”.   

We will fix this now. 

__7. Under Common Event Infrastructure Bus Member, click the Edit... button.

The CEI ME data source screen will appear. 
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__8. On the right, under Additional Properties, click JDBC Data Source.

The screen will show properties that the data source is using to connect.  
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__9. Scroll a little bit down and locate the drop-down labeled Component-managed 
authentication alias.

Notice that it is currently set to (none).  That is the problem; when attempting to use this 
data source, ESB is not using any authentication alias which basically means it is 
attempting to connect to a database without using any user name/password.   

As stated earlier, this should have been set automatically when we used the deployment  
environment wizard, but was not.  A bug, most likely.   We will fix it now.

__10. Change the drop-down to CEIME_MyToplogy.AppTarget_Auth_Alias.

__11. Scroll down and click OK.

We now need to save our changes.  However, we also want all our changes propagated to 
all our cluster members.  

__12. In the Messages box, click the Preferences link.
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The Console Preferences window will appear. 

__13. Check the box Synchronize changes with Nodes.

__14. Click Apply.

__15. Now click Save in the Messages box.  All configuration changes will be saved and 
pushed down to all members of the cluster. 

__16. Click OK.
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Now, let us test our changes.  

__17. In the left pane, under Servers, click Clusters.

__18. In the right pane, click the cluster. (MyTopology.AppTarget)

__19. In the right pane, under Business Integration, expand Common Event 
Infrastructure and click Common Event Infrastructure Server.

__20. Scroll down and locate the section Common Event Infrastructure Bus Member.

Testing this connection failed last time; now that we have fixed it, however, things should 
be much better. 

__21. Click Test Connection.

A success message should appear.

Problem fixed!

We have completed fixing the CEI configuration.  If we had not done this, any 
applications using CEI would fail.  In a later lab, we will actually be testing such an 
application and we will see CEI in action.

__22. Logout the admin console and close the browser.

__23. Close any open window.

Congratulations.  You have completed creating the deployment environment.  You are 
now ready to deploy and run an ESB application. 

Part 7 - Review
In this lab, you created a deployment environment.  You:

• Used the Profile Management Tool to create a new custom profile

• Created the MEDB database using a script found in the deployment manager's 
profile
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• Created a deployment environment using the admin console

• Created the EVENT database using a script found in the deployment manager's 
profile

• Fixed a bug in the configuration of the CEI settings
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	Lab 1 -  Installing  WebSphere ESB
	Part 1 -  Install the Software
	__1.  Open a Windows Explorer window.
	__2.  Navigate to the <WESB_SOFTWARE_DIR>\ directory substituting the value of the <WESB_SOFTWARE_DIR> variable with the location mentioned in the list of directory paths at the beginning of these labs.  Check with your instructor if you can't find the directory listed.
	__3.  Double click on the launchpad.exe file to run it.
	__4.  Click the link labeled IBM WebSphere ESB installation.
	__5.  Click the link for Launch the installation wizard for WebSphere ESB.
	__6.  Click Next.
	__7.  The Software License Agreement screen will appear.  Select I accept both the IBM and the non-IBM terms and click Next.
	__8.  The System Prerequisites Check screen will appear.  You should see a Passed message.  If you do not, contact your instructor immediately.
	__9.  Click Next.
	__10.  Leave Typical Installation selected. 
	__11.  Click Next.
	__12.  Make sure the box for WebSphere Enterprise Service Bus Samples is left unchecked.
	__13.  Click Next.
	__14.  Change it to C:\IBM\WebSphere\ESB 
	The default  (with \Program Files\ in the path) is a little on the long side – and IBM software running on the Windows platform has occasionally had problems with path names over 256 characters.  Adding “Program Files” does not help.  
	__15.  Write down this installation directory as the value of the <WESB_ROOT> variable in the list of directory paths at the beginning of these labs.
	__16.  Click Next.
	__17.  Select None.
	__18.  Click Next.
	A warning screen will appear.  
	__19.  Click Yes.
	__20.  Click Next.
	__21.  Click Finish.
	__22.  Close the Launchpad program.  We no longer need it. 

	Part 2 -  Examine the Installation
	__1.  Using file explorer, go to <WESB_ROOT>\logs\install folder.
	__2.  Open log.txt using wordpad. The very last line should say:
	__3.  Click Start > All Programs > IBM WebSphere and you will see two shortcuts listed underneath:  Application Server Network Deployment v6.1, and Enterprise Service Bus 6.2
	__4.  Also, notice that the shortcuts listed underneath Application Server Network Deployment v6.1 and Enterprise Service Bus 6.2 are almost identical.
	__5.  Next, we will view the version information of the installed products. Open a command prompt  window.  You can do this by selecting Start-> Run, entering cmd and then pressing OK.  
	__6.  Change directories using the cd command to the <WESB_ROOT>\bin directory. 
	__7.  Enter the command 
	__8.  Last but not least, open a Windows Explorer window.
	__9.  Navigate to the <WESB_ROOT> directory you wrote down in the notes at the beginning of these labs.  This serves as the main installation directory for WESB
	__10.  Close all open windows.

	Part 3 -  Review

	Lab 2 -  Configuring the Deployment Manager
	Part 1 -  Create the Deployment Manager Profile
	__1.  From the Start menu, select All Programs | IBM WebSphere | Enterprise Service Bus 6.2 | Profile Management Tool.
	__2.  Click Next.
	__3.  Select WebSphere Enterprise Service Bus as shown above and click Next.
	__4.  Select Deployment manager profile.
	__5.  Click Next.
	The Profile Creation Options screen will appear.
	__6.  Select Advanced Profile Creation.
	__7.  Click Next.
	__8.  Leave the box checked and click Next.
	__9.  This path will be referred to as <DM_PROFILE_ROOT> throughout these labs; record this name in the Directory Path table in the first page of these lab exercises.
	__10.  Accept the defaults and click Next.
	__11.  Accept these defaults and click Next.
	__12.  Set the User name to wasadmin
	__13.  Set the Password and Confirm password to wasadmin
	__14.  Click Next.
	__15.  Accept the defaults and click Next.
	__16.  Uncheck the box marked Run the deployment manager as a Windows service.
	__17.  Click Next.
	__18.  Change the Choose a database product dropdown to DB2 Universal.
	__19.  Check the box marked Delay execution of database scripts.
	__20.  Click Next.
	The Database Configuration (Part 2) screen will appear. 
	__21.  Set the User name, Password and Confirm password fields to db2admin
	__22.  Click Next.
	__23.  Click Create.
	__24.  Uncheck the box Launch the First steps console and click Finish.
	The Deployment Manager profile has now been created!

	Part 2 -  Create the WPRCSDB Common Database
	As mentioned above, the deployment manager in a WESB environment requires a database, known as the Common DB, to operate. During the the previous lab part, you configured the deployment manager to use a database called WPRCSDB as this Common DB, but did not actually create the required database and tables.  We will do so now.
	Creating the tables involves executing scripts that were generated by the Profile Management Tool at profile creation time.  They can be found in the profile directory.
	__1.  Open a command prompt window.
	__2.  In the command prompt window, cd to <DM_PROFILE_ROOT>\dbscripts\CommonDB\DB2\WPRCSDB
	__3.  Enter the following command:
	__4.  After a few moments, you will be prompted for a password. Enter db2admin
	Type carefully as the window will not echo your characters! 
	__5.  In the same command prompt window, enter the command db2cmd
	__6.  A new command window will open.  In that window, enter the command:
	__7.  Enter the command:
	__8.  Close all command prompt windows.

	Part 3 -  Start the Deployment Manager
	__1.  Open a command prompt window and cd to  <DM_PROFILE_ROOT>\bin
	__2.  There, enter the command 
	__3.  The deployment manager will boot.  Wait until you see the following message:
	__4.  Open a web browser, and navigate to:
	Your browser throw a warning about an untrusted certificate or any kind of security alert.  Ignore the warning and proceed  (for example, on Internet Explorer, simply click Yes to proceed.)
	__5.  Enter wasadmin for the username and password and click Log in.
	The admin console will appear.  This is where you will be doing the bulk of your administration over the following labs. 
	__6.  Using your browser, bookmark this link, as you will be continually logging into the admin console throughout these exercises.
	__7.  Logout of the admin console, by clicking the Logout link in the top right corner of the admin console.
	__8.  Close the browser.

	Part 4 -  Backup the Configuration
	We will now make a backup of the configuration.  Make a habit of doing so on a regular basis; that way, in the event of a failure, you can always restore the configuration.
	__1.  At the command prompt, from the profile's bin directory, enter the following command:
	The command will execute. 
	__2.  A Login at the Target Server screen will appear.  Enter wasadmin for the User Identity and User Password.
	The script will continue execution. The deployment manager will be stopped, and the backup file will be created.

	Part 5 -  Review

	Lab 3 -  Creating the Deployment Environment
	Part 1 -  Create the Custom Profile
	__1.  Start the Deployment Manager if it is not already running.  To check this, try logging into the admin console.  If you cannot, start the deployment manager first.  Make sure the deployment manager is running before continuing these steps.
	__2.  From the Start menu, select All Programs > IBM WebSphere > Enterprise Service Bus 6.2 > Profile Management Tool.
	__3.  Click Create.
	__4.  On the Important information for Version 6.1  screen, click Next.
	__5.  Select WebSphere Enterprise Service Bus.
	__6.   Click Next.
	__7.   Select Custom profile.
	__8.  Click Next.
	__9.  Select Advanced profile creation.
	__10.  Click Next.
	__11.  Accept the defaults and click Next.
	__12.  Click Next.
	__13.  Set the  User name and Password to wasadmin
	__14.  Click Next.
	__15.  Accept the defaults and click Next.
	The Database Configuration screen will appear. 
	__16.  Change the drop-down to DB2 Universal.
	__17.  Click Next.
	__18.  Click Create.
	The profile will be created.  Wait patiently.
	Eventually, the profile creation will complete.  
	__19.  Uncheck the box marked Launch the First steps console and click Finish.
	__20.  Close the Profile Management Tool.
	The profile has been created!
	Next, we need to create a database that is required for ESB (with SCA enabled) to run.

	Part 2 -  Create the MEDB database
	__1.  Open a new command prompt window.
	__2.  In the new window, cd to <WESB_ROOT>\bin
	__3.  Enter the command:
	__4.  Now, enter the command:
	__5.  In the command window, enter db2cmd
	__6.  A new command window will open.  In that one, enter the command 
	__7.  Now, enter the following :
	__8.  Now, enter:
	__9.  Next, enter:
	__10.  Close all command prompt windows.

	Part 3 -  Verify Node Federation
	__1.  Login to the admin console:
	__2.  On the left hand navigation bar expand System administration and click Nodes.
	__3.  Verify that two nodes are displayed – one for the deployment manager and the other where applications will be hosted.

	Part 4 -  Create the Deployment Environment 
	__1.  In the left pane of admin console, expand Servers and click Deployment Environments.
	__2.  In the right pane, click New.
	__3.  Set the Deployment environment name to MyTopology
	__4.  Click Next.
	__5.  Select Single Cluster and click Next.
	__6.  Select the node by checking its box and click Next.
	__7.  On the Clusters screen, click Next.
	__8.  On the System REST Service Endpoints screen, click Next.
	__9.  For the first two items on the list (Common Event Infrastructure), set the Database Instance to EVENT
	__10.  For the next two items (Service Component Architecture), set the Database Instance to MEDB
	__11.  Uncheck all the Create Tables boxes.  We have already created the tables for the MEDB database, and we will manually create the tables for the EVENT database afterwards.
	__12.  Click Next.
	__13.  On the Security screen, click Next.
	__14.  On the Summary screen, click Finish and Generate Environment.
	__15.  Click Save Changes. (second button)
	__16.  In the left pane, expand Servers and click on Clusters.  The right pane will show a table of defined clusters.  You should see the one that was just created: MyTopology.AppTarget
	__17.  In the table click MyTopology.AppTarget
	__18.  On the right, under Additional Properties, expand Cluster members.
	__19.  Logout of the admin console and close the browser.

	Part 5 -  Complete Configuring the EVENT Database
	__1.  Open a new command prompt window.
	__2.  In the command prompt window, cd to <DM_PROFILE_ROOT>\databases\event\MyTopology.AppTarget\dbscripts\db2
	__3.  Enter the command:
	The script will execute.  It should execute without any problems. 

	Part 6 -  Fixing CEI
	__1.  Logon to the admin console. 
	__2.  In the left pane, expand Servers and click on Clusters.  The Server Clusters table will appear on the right.
	__3.  Click the link for our cluster. (MyTopology.AppTarget)
	__4.  On the right, under Business Integration, expand Common Event Infrastructure.
	__5.  Click Common Event Infrastructure Server.
	The Common Event Infrastructure Server screen will appear. 
	__6.  Under Common Event Infrastructure Bus Member,  (which is the lower box) click Test Connection.
	__7.  Under Common Event Infrastructure Bus Member, click the Edit... button.
	__8.  On the right, under Additional Properties, click JDBC Data Source.
	__9.  Scroll a little bit down and locate the drop-down labeled Component-managed authentication alias.
	__10.  Change the drop-down to CEIME_MyToplogy.AppTarget_Auth_Alias.
	__11.  Scroll down and click OK.
	__12.  In the Messages box, click the Preferences link.
	__13.  Check the box Synchronize changes with Nodes.
	__14.  Click Apply.
	__15.  Now click Save in the Messages box.  All configuration changes will be saved and pushed down to all members of the cluster. 
	__16.  Click OK.
	__17.  In the left pane, under Servers, click Clusters.
	__18.  In the right pane, click the cluster. (MyTopology.AppTarget)
	__19.  In the right pane, under Business Integration, expand Common Event Infrastructure and click Common Event Infrastructure Server.
	__20.  Scroll down and locate the section Common Event Infrastructure Bus Member.
	__21.  Click Test Connection.
	__22.  Logout the admin console and close the browser.
	__23.  Close any open window.

	Part 7 -  Review

	Lab 4 -  Install an SCA Module Application
	Part 1 -  Install Service Provider Application
	__1.  Access the Administrative Console by opening a browser and entering the URL:   
	__2.  Log on as the user wasadmin
	__3.  In the left pane, expand the Applications group and click Install New Application.
	__4.  Make sure Local file system is selected and click the Browse button.
	__5.  In the Choose file dialog, navigate to C:\LabFiles\RoutingExampleApp.ear and click Open.
	__6.  Click Next.
	__7.  Click Next at the bottom of the page.  
	__8.  Click Next.
	__9.  Click the Finish button to start the installation.
	__10.  Click the Save link to save changes.
	__11.  Once you see the message, The configuration synchronization complete for cell, click OK.  
	We now need to start the actual server instance that will host the application.  We will do so by starting the cluster (which implies starting all the servers within that cluster – which at the moment includes the server that we wish to target)
	__12.  In the left pane. expand the Servers group and click Clusters.
	__13.  Start cluster MyTopology.AppTarget by checking the box next to it and clicking the Start button.
	__14.  In the left pane, expand the Servers group and click Application Servers.
	__15.  If you check its Status, you should see the green arrow representing that the server has started. If not, wait a few more minutes and then click the refresh icon next to the Status column header to refresh the page. 
	__16.  Confirm that the RoutingExampleApp application started up successfully by expanding the Applications group and clicking the Enterprise Applications link.

	Part 2 -  Install the Service Consumer
	__1.  In the left pane, expand the Applications group and click Install New Application.
	__2.  In the right pane, make sure Local file system is selected and click the Browse button.
	__3.  In the Choose file dialog, select <LABFILES_DIR>\OnlineOrderApp.ear and click Open.
	__4.  Click Next.
	__5.  Click Next.  
	__6.  Click on the Next button.
	__7.  Click the Finish button to start the installation.
	__8.  Click the Save link.
	__9.  Once you see the message, The configuration synchronization complete for cell, click OK.
	__10.  In the left pane, expand the Applications group and click the Enterprise Applications link.  You should see OnlineOrderApp listed.
	__11.  Check the box to the left of OnlineOrderApp and click the Start button.  The application status should changed to Started within a moment.

	Part 3 -  List the SCA Modules
	__1.  In the left pane, expand the Applications group and click the SCA Modules link.
	__2.  Check the box next to RoutingExample and click the Stop button. 
	__3.  In the left pane, click the Enterprise Applications link under the Applications group.  
	__4.  Click again on the SCA Modules link under the Applications group (in the left pane).  
	__5.  Check the box next to RoutingExample and click the Start button. 
	__6.  Confirm that RoutingExampleApp started back up.
	__7.  Log out of the Administrative Console.

	Part 4 -  Test the Service Provider Application
	__1.  Open a browser and enter the URL: 
	__2.  Enter some sample input as shown below:
	__3.  Click Register. 
	The browser should display the following page:
	__4.  To do so, in Windows Explorer, navigate to the <PROFILE_ROOT>\Custom01\logs\MyTopology.AppTarget.<hostname>Node01.0 directory, and open the SystemOut.log file using Notepad.
	__5.  Scroll to the bottom of the file and you'll notice the following messages:
	__6.  Close the file.
	__7.  Click the Back button in the browser to go back to the registration page. Change the Country from USA to Canada and click Register. 
	__8.  Open the SystemOut.log file using Notepad again.
	__9.  Scroll to the bottom of the file and you'll  notice the following new messages:
	__10.  Close the file.  

	Part 5 -  Confirm Mediation Logging
	__1.  Open the DB2 Control Center by selecting Start > All Programs > IBM DB2 > DB2COPY1 (Default) > General Administration Tools > Control Center.
	__2.  In the Control Center View dialog, uncheck the Show this window at startup time option and click OK.
	__3.  In the left pane, expand the All Databases folder.  
	__4.  A list of the databases that have been created thus far will be listed.  You should see WPRCSDB (Common database), MEDB (Message Bus database), and EVENT  (for CEI).
	__5.  Expand WPRCSDB and click on the Tables folder.  A list of tables will be displayed in the upper-right panel.
	__6.  Click the Schema column to sort the rows by schema. You'll notice some of the tables that were created earlier when you configured the Common database.
	__7.  Scroll through the list of tables until you see the MSGLOG table.  Right click on MSGLOG and select Query from the pop-up menu.  
	__8.  Click the green arrow to execute the query, which selects all the records from the MSGLOG table.  
	__9.  Exit the Control Center.
	__10.  Close all browsers.
	__11.  Back up and restart the profiles following the steps in Lab 2. 
	__12.  After the backup, start the deployment manager.
	__13.  Login the admin console and verify the cluster server  is started as well as all the applications.
	__14.  Logout and close the browser.

	Part 6 -  Review

	Lab 5 -  Try Out a Web Service
	Part 1 -  Import the Application
	__1.  Open WID by selecting Start > All Programs > IBM WebSphere Integration Developer > IBM WebSphere Integration Developer V6.2 >  WebSphere Integration Developer V6.2 
	__2.  In the Workspace Launcher dialog, change the workspace to C:\workspace
	__3.  Click OK.
	__4.  The Welcome view may be open. close it.
	__5.  Choose File > Import from the menu bar.
	__6.  Scroll down.  Expand Other and select Project Interchange.
	__7.  Click Next.
	__8.  Click the Browse button next to From zip file.
	__9.  Navigate to <LABFILES_DIR>\source\RoutingExampleCEI.zip and click Open.
	__10.  Back in the Import Project Interchange Contents dialog, check the box next to RoutingExample.
	__11.  Click Finish.
	__12.  In the Business Integration view, you should now see the RoutingExample project  listed. 
	__13.  From the menu, select Window > Show View > Problems.
	__14.  The Problems view will open at the bottom of WID.  Make sure there are no errors.  However, there should be some warnings listed.

	Part 2 -  Inspect the Solution Assembly
	__1.  In the Business Integration view, expand the RoutingExample project.  
	__2.  Double click on Assembly Diagram to open it.
	Also, observe that the AccountingMediation component is exported as a web service called AccountingMediationExport. Any consumer that needs to create a customer account in a generic manner needs to use this web service.  
	__3.  To verify that AccountingMediation is exposed as a web service, right click on the AccountingMediationExport component and select Show in Properties.  
	__4.  Last but not least, click on the Binding tab on the left side of the Properties view.
	Notice that the Address field shows the service endpoint (http://localhost:9080/RoutingExampleWeb/sca/AccountingMediationExport), which is used to invoke the web service.  The port name and service name are also listed, which we will examine in the corresponding WSDL file.
	__5.  Close the file.

	Part 3 -  Examine the WSDL File
	__1.  In the Project Explorer view, expand RoutingExample > Web Service Ports.  You should see AccountingMediationExport_GenericAccountingHttpPort listed. Notice this corresponds with the port name you saw in the last part.
	__2.   To see the physical file, right click on AccountingMediationExport_GenericAccountingHttpPort and select Show Files. 
	__3.  Double click on AccountingMediationExport_GenericAccountingHttp_Service.wsdl
	__4.  Click OK when prompted to launch the file with the WSDL editor.
	__5.  Click on the Source tab at the bottom of the editor.
	__6.  In the Physical Resources view, double click on the GenericAccounting.wsdl file.
	__7.  Close the Interface Editor. 
	__8.  In the Physical Resources view, right click on GenericAccounting.wsdl and select Open With > WSDL Editor.
	__9.  Click the Source tab at the bottom of the editor to view the raw source.
	__10.  Scroll down and locate the <wsdl:portType> tag.  
	The addCustomerToSystem element is defined in the <wsdl:types> tag.  The <wsdl:types> tag is used to define the elements and data types used by a web service in a generic, language-neutral fashion.  It does so using XML schemas.  
	The addCustomerToSystem element is considered a complex element, which means it's made up of other elements and can potentially have attributes.  We see it's composed of an element named customer of type AddressGBO.  For re-usability, the AddressGBO data type is defined in an external XML schema file called http.RoutingExample.xsd.
	__11.  In the Physical Resources view, scroll up, expand the the xsd-includes folder, and double click on the http.RoutingExample.xsd file. 
	__12.   Click Yes when prompted to open the file using the XSD editor.
	__13.  Click the Source tab at the bottom of the XSD editor.
	__14.  Since the customer element is of type AddressGBO, it stands to reason it's defined inside the AddressGBO.xsd file.  Double click on the file, which is located directly underneath the RoutingExample project.  
	The Business Object editor view will open.
	__15.  Now that we've examined the abstract elements that make up the WSDL file, let's go back to examining the AccountingMediationExport_GenericAccountingHttp_Service.wsdl file.  
	Finally, notice the <wsdl:service> tag. This contains the service endpoint information. For example:
	__16.  Close all open editors.

	Part 4 -  Unit Test the Web Service
	__1.  Open the Business Integration view and locate AccountingMediationExport_GenericAccountingHttpPort
	__2.  Right-click on the file and select Web Services > Test with Web Services Explorer. 
	__3.  Click on the operation addCustomerToSystem in the Actions pane. 
	__4.  Click the Add link next to each field and input a corresponding value to represent a customer as shown below:
	__5.  Click the Go button at the bottom of the Actions pane to invoke the addCustomerToSystem operation.
	The Status pane shows the result of the operation.  Unfortunately for us, the operation is a one-way operation, which means the operation only takes input, but doesn't return any output.  Consequently, the only message you will see is: There is nothing to be displayed in the form view. Please switch to the source view for the SOAP request and response. 
	__6.  To verify that the registration was successful, open the SystemOut.log file for the server using Notepad.  Once again, it's located inside the <CSTM_PROFILE_ROOT>\logs\MyTopology.AppTarget.<localhost>Node01.0 directory.  Scroll to the bottom of the file and make sure you see the following messages:
	__7.  Close the log file.
	__8.  Now let's examine the SOAP request.  In the Status pane, click the Source link. WID will show the SOAP request message.  
	The request message will look like this:
	Review and verify the following items:
	The top level element within the Body element is addCustomerToSystem. This is something we had already expected. According to the wrapped document literal style, the top level element within the body has the same name as the implementing method: addCustomerToSystem.
	Each child element of addCustomerToSystem will constitute an input parameter to the method. In our case, there is only one input: customer.
	__9.  Close the Web Services Explorer.
	__10.  Exit WID.

	Part 5 -  Review

	Lab 6 -  Configure Common Event Infrastructure
	Part 1 -  Install CEI Application 
	__1.  Login to the admin console.
	__2.  In the left pane, expand the Applications group and click Enterprise Applications.
	__3.  Check the box next to RoutingExampleApp and click the Update button.  
	__4.  Make sure the Replace the entire application radio button is selected under Application update options.
	__5.  Click the Local file system radio button and then the Browse button.
	__6.  In the Choose file dialog, select <LABFILES_DIR>\RoutingExampleAppCEI.ear and click Open.
	__7.  Scroll to the bottom of the page and click Next.
	__8.  The installation wizard will be displayed.  Click on the Step 3 link (on the left) to bypass the other steps and advance to the Summary page.  
	__9.  Click the Finish button to start the installation.
	The installation will take a moment or two to run.  Once the installation is finished, a success message should be displayed.  
	__10.  Click the Save link.
	__11.  Once you see the message, The configuration synchronization complete for cell, click OK.  

	Part 2 -  Configure CEI Security
	__1.  In the left pane, expand Service Integration > Common Event Infrastructure and click Event service.
	__2.  In the right pane, under Additional Properties, click Map security roles to users or groups.
	__3.  Check all 6 boxes under the Select column.
	__4.  Check all 6 boxes under Everyone?
	__5.  Click OK.
	__6.  Click the Save link.
	__7.  When the synchronization is complete, click OK. We have completed configuring CEI security.

	Part 3 -  Test CEI
	__1.  To test the RoutingExampleApp application's mediation flow, open another browser and enter the URL: 
	__2.  Enter some sample input as shown below:
	__3.  Click Register. The browser should display the following page:
	__4.  Back in the Administrative Console, in the left pane, expand the Integration Applications group and click on Common Base Event Browser.  
	The Common Base Event (CBE) Browser can also be accessed outside of the Administrative Console by using the URL:
	__5.  Scroll to the bottom of the page and click the Get Events button.
	__6.  The Number of Events counter in the left pane should be to 1.
	__7.  Click the All Events link under the Event Views heading to view the event.
	__8.    Click the Select radio button and the Event Data should be displayed in the bottom pane.
	__9.  Scroll down and you will see that the event was generated by the RoutingExample module and the EventEmitter1 mediation primitive.  The contextDataElement elements indicate that the addCustomerToSystem operation was invoked by the consumer on the mediation flow.
	__10.  Log out of the Administrative Console.
	__11.  Close all browsers.

	Part 4 -  Review

	Lab 7 -  Deploying a Complex Mediation Flow
	Part 1 -  The Business Problem
	Part 2 -  Import the Solution Projects in WID
	__1.  Launch WID using the same workspace.
	__2.  From the menubar, select File > Import.
	__3.  Expand Other and select Project Interchange.
	__4.  Click Next.
	__5.  Click the Browse button and select C:\LabFiles\PriceQuote.zip and click Open.
	__6.  Click Select All to select all projects in the ZIP file.
	__7.  Click Finish.
	__8.  Click the Problems tab at the bottom to find out if the build had found any errors.

	Part 3 -  Understanding the Build Process
	__1.  Click the Build Activities tab at the bottom to open that view.
	__2.  Make sure that Validate and update deploy code is selected. This means, both steps will be performed during a build. If only Validate was selected, you could click Update Deploy Code to generate and compile the required code.

	Part 4 -  Review the Projects
	Part 5 -  Review the Mediation Flow
	__1.  Expand PriceQuoteFlow > Integration Logic > Mediation Flows.
	__2.  Double click OrderMediation to open the mediation flow.
	__3.  Close the mediation flow.

	Part 6 -  Review the Assembly Diagram
	__1.  Double click Assembly Diagram under the PriceQuoteFlow project.
	__2.  Select ACMEImport on the assembly diagram.
	__3.  At the bottom, click the Properties tab. 
	__4.  Then click the Bindings tab.
	__5.  Close the assembly diagram.

	Part 7 -  Export EAR Files
	__1.  Under the Build Support project, double click build.xml to open it.
	__2.  Make sure that the C:\temp folder exists. If not, create it. This is where the EAR files will be created.
	__3.  Back in WID, right click build.xml and select Run As > 3 Ant Build...
	__4.  Select the Export EAR target.
	__5.  Click the JRE tab.
	__6.  Select Run in the same JRE as the workspace. This is needed so that the definition of the extended task earExport can be found.
	__7.  Click Apply. This will save the JRE selection so that you don't have to select it again.
	__8.  Click Run to run the script.
	__9.  From the menu, select Window > Show View > Console.
	__10.  In the Console view, go to the bottom and make sure that the build was successful.
	__11.  Verify that four EAR files are created in C:\temp.
	__12.  We are done with the build process. Exit out of WID (File > Exit).

	Part 8 -  Deploy the Applications
	__1.  Open a command prompt window.
	__2.  Change to the <DM_PROFILE_ROOT>\bin folder.
	__3.  Run the following command:
	__4.  If it is not started then enter the command startManager.bat and wait until starts.
	__5.  Log into admin console as wasadmin.
	__6.  Expand Applications.
	__7.  Click Install New Application.
	__8.  Click Browse.
	__9.  Select C:\temp\PriceQuoteFlowApp.ear
	__10.  Click Open.
	__11.  Click Next.
	__12.  In the Select installation options page, click Next.
	__13.  In the Map modules to servers page, click Next.
	__14.  Click Finish.
	__15.  Once deployment ends, click Save.
	__16.  Similarly, install applications from these EAR files, save after every installation and wait until synchronization is completed.

	Part 9 -  Start Applications
	__1.  Expand System administration.
	__2.  Click Nodes.
	__3.  Make sure that the node is synchronized. If not, select it and click Synchronize.
	__4.  Expand Applications and click Enterprise Applications.
	__5.  Select the check box for these applications.
	__6.  Click Start.

	Part 10 -  Test the Solution
	__1.  Open a web browser and enter the URL of the web based application used to place an order:
	__2.  Enter some values.
	__3.  Click Go.
	__4.  Make sure that you see the success message.
	__5.  Open the server's SystemOut.log file from <CSTM_PROFILE_ROOT>\logs\MyTopology.AppTarget.<HOSTNAME>Node01.0.
	__6.  Go to the very end of the file. The log entries will tell a story. 
	__7.  Close the log file.

	Part 11 -  Edit Endpoint Address
	__1.  In the admin console, expand Applications and click SCA Modules.
	__2.  Click PriceQuoteFlow.
	__3.  Expand Imports and you will notice the two imports.
	__4.  Expand AJAXImport and then Binding.
	__5.  Click JAX-Web Service...
	__6.  Click Edit next to it.
	__7.  Change the URL to use plain HTTP: 
	__8.  Click OK.
	__9.  Click Save.
	__10.  Click OK after synchronization is complete. 
	__11.  Stop and start the PriceQuoteFlow SCA module.
	__12.  Open a new browser and enter:
	__13.  Enter some information and click Go.
	__14.  Verify that the message "Order was created successfully" appears in the browser.
	__15.  Open the SystemOut.log file of the server.
	__16.  Go to the bottom of the file and make sure the solution is working.
	__17.  Close the log file.

	Part 12 -  Troubleshooting Endpoint Address
	__1.  Using the steps from the previous part, set the port number of the endpoint URL for AJAXImport to 9081
	__2.  Make sure you saved and the synchronization is complete. 
	__3.  Stop and start the PriceQuoteFlow SCA module.
	__4.  Open a new browser and enter:
	__5.  Enter some information and click Go.
	__6.  Open the SystemOut.log file of the server. 
	__7.  Go to the very end. You will see a bunch of exception stack trace.
	__8.  The very first stack trace will show this.
	__9.  But, which import specifically is causing the problem? For that, scroll down and look or search for "SCA context".
	__10.  Close the log file.
	__11.  Fix the port number in the endpoint address. Save and wait for synchronization. Then restart the SCA module.
	__12.  Test the application and make sure is working fine.
	__13.  Logout the admin.
	__14.  Close all open browsers and windows.

	Part 13 -  Review

	Lab 8 -  Application Integration Using JMS Messaging
	Part 1 -  Business Logic and Architecture
	Part 2 -  Create the Message Queues
	__1.  Start the DMGR server unless it is already running.
	__2.  Log in to admin console as wasadmin.
	__3.  Click Service integration.
	__4.  Click Buses.
	__5.  Click New to create a new message bus.
	__6.  Enter DemoBus as the name.
	__7.  Clear the Bus Security checkbox to disable security protection for the bus.
	__8.  Click Next.
	__9.  Click Finish.
	__10.  Click DemoBus from the list of buses.
	__11.  Click Bus members.
	__12.  Click Add.
	__13.  Select Cluster.
	__14.  Click Next.
	__15.  Choose Data store.
	__16.  Click Next.
	__17.  Enter jdbc/WPSDB as the data source JNDI name.
	__18.  Select WPSDB_Auth_Alias as the database authentication alias.
	__19.  Click Next.
	__20.  Click Finish to add the bus member.
	__21.  Click Buses on the left hand navigation tree.
	__22.  Click DemoBus.
	__23.  Click Destinations.
	__24.  Click New.
	__25.  Choose Queue (default). Note: For pub/sub you will create a topic instead.
	__26.  Click Next.
	__27.  Enter AccountingRequestQ as the identifier.
	__28.  Click Next.
	__29.  The bus member to host the queue should be the cluster. Click Next.
	__30.  Click Finish to create the queue.
	__31.  Similarly, create another queue called AccountingResponseQ
	__32.  Click the Save link to save your changes.
	__33.  Click OK when the synchronization is complete.

	Part 3 -  Create JMS Resources
	__1.  In the left hand navigation tree, expand Resources > JMS.
	__2.  Click Queue Connection Factories.
	__3.  Set the scope to the cluster MyToplogy.AppTarget as shown below.
	__4.  Click New.
	__5.  Click OK to create the resource for the default messaging provider.
	__6.  Enter these values:
	__7.  Click OK.
	__8.  Click Queues on the left side.
	__9.  Set the scope to the cluster MyTopology.AppTarget.
	__10.  Click New.
	__11.  Click OK.
	__12.  Enter these values.
	__13.  Click OK.
	__14.  Click New again and create another destination.
	__15.  Click OK.
	__16.  Enter the destination as follows.
	__17.  Click OK.
	__18.  Save changes.
	__19.  Click OK when the synchronization is complete.
	__20.  Logout and close the Admin Console.

	Part 4 -  Review JMS Enabled Solution
	__1.  Launch WID using the same workspace.
	__2.  Import all projects from the project interchange file C:\LabFiles\PriceQuoteJMS.zip. You will be asked to overwrite the PriceQuoteFlow module. Choose to do so.
	__3.  Wait for build to finish.
	__4.  Close all open files.
	__5.  Open the assembly diagram for the PriceQuoteFlow module.

	Part 5 -  Review the JMS Import Configuration
	__1.  In the assembly diagram, select the JMS import  AccountingApp.
	__2.  In the Properties view, select the End-point configuration tab.
	__3.  Select the JMS Destinations tab.
	__4.  Expand Send Destinations Properties.
	__5.  Make sure that the send destination JNDI name is set to jms/AccountingRequestQ.
	__6.  Similarly, verify the JNDI name of the receive destination queue.
	__7.  Expand Callback Destination Properties.
	__8.  Make sure that Specify properties for configuring new messaging provider resource checkbox is selected. Here we will provide enough information so that WebSphere ESB can dynamically create the destination.
	__9.  The Bus name field should be set to DemoBus
	__10.  Close all open files.
	__11.  Exit out of WID.

	Part 6 -  Update the PriceQuoteFlow Module
	__1.  Open the Admin console and login as wasadmin.
	__2.  Select Applications > Enterprise Applications.
	__3.  Select the checkbox for PriceQuoteFlowApp.
	__4.  Click Update.
	__5.  Select the Replace the entire application option.
	__6.  Using the Browse button, select C:\LabFiles\PriceQuoteFlowAppJMS.ear and click Open.
	__7.  Scroll all the way down and click Next.
	__8.  Click Next at Step1 page.
	__9.  Click Next at Step2 page.
	__10.  Click Finish.
	__11.  Save changes and wait for synchronization.

	Part 7 -  Deploy Accounting (MDB) Application
	__1.  Expand Resources > JMS.
	__2.  Click Activation specifications.
	__3.  Set the scope to the cluster MyTopology.MyTarget.
	__4.  Click New.
	__5.  Click OK.
	__6.  Enter the following values.
	__7.  Scroll down and click OK.
	__8.  Save changes and wait for synchronization.
	__9.  On the left hand side, expand Applications and click Install New Application.
	__10.  Use the Browse button to select C:\LabFiles\SimpleAccountingApp.ear and click Open.
	__11.  Click Next.
	__12.  Click Next at Step1 page.
	__13.  Click Next at Step2 page.
	__14.  Click Finish.
	__15.  Save changes and wait for synchronization.
	__16.  On the left hand side click Enterprise Applications.
	__17.  Click SimpleAccountingApp.
	__18.  Click Message Driven Bean listener bindings.
	__19.  Make sure that the activation specification option is selected.
	__20.  We are all set, go back to the Enterprise Application page. 
	__21.  Start the SimpleAccountingApp application.
	__22.  Wait for a minute. Then refresh the status of the applications to make sure that the new application has started. 
	__23.  Also open the server's SystemOut.log file and make sure that there are no exceptions. The end of the file should have the line. 
	__24.  Close the log file.

	Part 8 -  Test
	__1.  Open a web browser and enter the URL:  
	__2.  Enter some values and then click Go. Make sure that the form submits successfully.
	__3.  Open server's SystemOut.log file using notepad.
	__4.  Search for QuoteMDB to locate log messages from the MDB.
	__5.  Make sure the winning supplier got the order.
	__6.  Close the log file.

	Part 9 -  Review JMS Endpoint Address
	__1.  On the left hand side, click SCA modules.
	__2.  Click PriceQuoteFlow.
	__3.  Expand Imports > AccountingApp > Binding.
	__4.  Click JMS.
	__5.  For sending messages, the JNDI names of the connection factory and send destination queue can be set here.
	__6.  Logout the admin console and close all the browsers.

	Part 10 -  Review

	Lab 9 -  Application Integration Using MQ JMS Binding
	Part 1 -  Business Logic
	Part 2 -  Understand the Solution
	Part 3 -  Create MQ Resources
	__1.  Launch MQ Explorer from the Start menu > All Programs > IBM WebSphere MQ > WebSphere MQ Explorer.
	__2.  Right click Queue Managers and select New > Queue Manager.
	__3.  Enter MyQM as the name of the queue manager.
	__4.  Click Finish.
	__5.  The queue manager will be started automatically. If needed, you can always start and stop it by right clicking it. We will keep it running.
	__6.  Expand MyQM.
	__7.  Right click Queues and select New > Local Queue.
	__8.  Enter InputQ as the name.
	__9.  Click Finish.
	__10.  Click OK to close the information dialog.
	__11.  Similarly, create another queue called OutputQ
	__12.  Verify that both queues are listed as follows.

	Part 4 -  Create JMS Resources
	__1.  Start DMGR if it is not running.
	__2.  Log into admin console.
	__3.  Expand Resources > JMS.
	__4.  Click Connection factories.
	__5.  Set the scope to the cluster MyTopology.AppTarget.
	__6.  Click New.
	__7.  Select WebSphere MQ messaging provider.
	__8.  Click OK.
	__9.  Set the name to MyQM QCF 
	__10.  Set the JNDI name to jms/MyQM
	__11.  Set the name of the queue manager to MyQM
	__12.  Make sure that the Transport type is set to BINDINGS.
	__13.  Click OK to create the connection factory.
	__14.  Save changes and wait for synchronization.
	__15.  On the left hand side, click Queues under Resources > JMS.
	__16.  Set the scope to our cluster.
	__17.  Click New.
	__18.  Select WebSphere MQ messaging provider.
	__19.  Click OK.
	__20.  Set the name of the destination to Customer Input Queue
	__21.  Set the JNDI name to jms/InputQ
	__22.  Set the Base queue name to InputQ
	__23.  Set the Base queue manager name to MyQM
	__24.  Set the Target client to MQ.
	__25.  Click OK.
	__26.  Similarly, create another JMS destination as follows.
	__27.  Save changes.
	__28.  Verify that both destinations have been created as follows.

	Part 5 -  Deploy the SCA Module
	__1.  You should be familiar by now to the steps needed to deploy an application. Follow those steps to deploy C:\LabFiles\MQTestApp.ear.
	__2.  Save changes.

	Part 6 -  Configure MQ JMS Binding
	__1.  On the left hand side, click SCA modules under Applications.
	__2.  Click MQTest.
	__3.  Expand Imports > MQJMSImport > Binding.
	__4.  Click MQJMS.
	__5.  Set the Connection Factory JNDI Name to jms/MyQM
	__6.  Set the Send MQ JMS Destination JNDI Name to jms/OutputQ
	__7.  Click OK.
	__8.  Expand Exports > MQJMSExport > Binding.
	__9.  Click MQJMS.
	__10.  Note that, the developers had configured the listener port with "wrong" JND names (DevQM and DevInQ). We must change them.
	__11.  Next to the Listener Port, click Configure.
	__12.  You will see this error message.
	__13.  Select and copy the name of the listener port (MQTest.CustomerMediationExport_LP). This will make things easier when we create the listener port.
	__14.  On the left hand side, expand Servers.
	__15.  Click Application servers.
	__16.  Click the application server.
	__17.  Under Communications expand Messaging.
	__18.  Click Message Listener Service.
	__19.  Click Listener Ports.
	__20.  Click New.
	__21.  As Name, enter MQTest.CustomerMediationExport_LP. Paste it if you had copied it earlier.
	__22.  As Connection factory JNDI name enter jms/MyQM
	__23.  As Destination JNDI name enter jms/InputQ
	__24.  Click OK.
	__25.  Save changes.
	__26.  Wait for synchronization to complete.
	__27.  On the left hand side, expand Servers and click Application servers.
	__28.  Click the application server.
	__29.  Under Communications expand Messaging.
	__30.  Click Message Listener Service.
	__31.  Click Listener Ports.
	__32.  Check the listener port and click Start to start it.
	__33.  Expand Enterprise Applications and click SCA modules.
	__34.  Click on MQTest.
	__35.  Expand Exports > MQJMSExport > Binding.
	__36.  Click MQJMS.
	__37.  Click the Configure button for the listener port. This time, system will find the listener port and open the properties page.
	__38.  Verify that the JNDI names are correctly typed (jms/MyQM and jms/InputQ).
	__39.  Click Cancel.

	Part 7 -  Test the SCA Module
	__1.  Open the SCA Modules page.
	__2.  Start the MQTest SCA module.
	__3.  Open MQ Explorer, if it is not already open.
	__4.  Expand Queue Managers > MyQM > Queues.
	__5.  Right click InputQ and select Put Test Message.
	__6.  Enter three comma separated fields for the customer data.
	__7.  Click Put Message.
	__8.  Click Close.
	__9.  The tool should automatically refresh the list of queues in a few seconds. Alternatively, click the Refresh toolbar button.
	__10.  The Current queue depth for the OutputQ should become 1.
	__11.  Right click OutputQ and select Browse Messages.
	__12.  Double click the message to view its contents.
	__13.  Click the Data property.
	__14.  The XML message is shown the the Message data field. To better view the message, copy the data and paste it in notepad.
	__15.  Click OK to close close the message.
	__16.  Click Close in the Message browser window.
	__17.  Close the MQ Explorer.
	__18.  Logout the admin console.
	__19.  Close any open browser.

	Part 8 -  Review

	Lab 10 -  Deploying and Configuring JCA Adapters
	Part 1 -  Understanding the Adapter Architecture
	Part 2 -  The Business Logic of the Sample Application
	Part 3 -  Deploy the Application
	__1.  Login in the admin console as wasadmin.
	__2.  Using the steps that should be already familiar to you deploy the EAR file C:\LabFiles\AdapterExampleApp.ear.
	__3.  Save changes and wait for synchronization.
	__4.  Do not start the application yet. We will configure the adapter first.

	Part 4 -  Configure the Inbound Adapter
	__1.  In the list of SCA modules, click AdapterExample.
	__2.  Expand the imports and exports as shown below.
	__3.  In the left hand side, click Enterprise Applications to view the list of applications.
	__4.  Click AdapterExampleApp.
	__5.  Click Manage Modules.
	__6.  Click the RAR module IBM WebSphere Adapter for Flat Files.
	__7.  Click Resource Adapter.
	__8.  Click J2C activation specifications.
	__9.  Click AdapterExample.FlatFileInbound_AS.
	__10.  Click J2C activation specification custom properties.
	__11.  Note that the eventDirectory property is currently set to C:\dev\in.
	__12.  Click eventDirectory.
	__13.  Set the value to C:\temp\in
	__14.  Click OK.

	Part 5 -  Configure the Outbound Adapter
	__1.  In the left hand side, click Enterprise Applications to view the list of applications.
	__2.  Click AdapterExampleApp.
	__3.  Click Manage Modules.
	__4.  Click the RAR module IBM WebSphere Adapter for Flat Files.
	__5.  Click Resource Adapter.
	__6.  Recall, outbound adapter is configured using the connection factory. Click J2C connection factories.
	__7.  Click AdapterExample.FlatFileOutbound_CF.
	__8.  Click Custom properties.
	__9.  Set the values of various properties as follows:
	__10.  Save changes.

	Part 6 -  Test the Application
	__1.  Create these folders if they do not exist.
	C:\temp
	C:\temp\in
	C:\temp\out
	__2.  Start the application AdapterExampleApp.
	__3.  A sample input file is made available as C:\LabFiles\file_in.xml. Open the file to have a look. 
	__4.  Close the file.
	__5.  Copy the C:\LabFiles\file_in.xml file into C:\temp\in. (After a couple seconds the file will disappear)
	__6.  Have a look at C:\temp\out. There should be a file called Customer.1.xml
	__7.  Copy the input file to C:\temp\in again. This will create Customer.2.xml in the output folder.
	__8.  Have a look at C:\temp\Sequence.txt. It should have the current sequence number.
	__9.  Close all open files.
	__10.  Logout the admin console and close the browser.

	Part 7 -  Review

	Lab 11 -  Administration Through Scripting
	Part 1 -  Launch wsadmin
	__1.  Open a command prompt window.
	__2.  Change directory to <DM_PROFILE_ROOT>\bin. 
	__3.  Launch wsadmin as follows.

	Part 2 -  List Installed Modules
	__1.  To view a list of all SCA modules run:
	__2.  To view the attributes of the PriceQuoteFlow SCA module run:

	Part 3 -  Work With Exports
	__1.  First, to view all exports in the module run:
	__2.  To view the attributes of the export called OrderTakerExport1, run:
	__3.  To view details of the binding used by the export, run:
	__4.  Note that the type of binding is a JAX-WS web service. To view more details about the of the export, run:

	Part 4 -  Work With Imports
	__1.  To view all the imports used in the PriceQuoteFlow module, run:
	__2.  To view more details about the import ACMEImport, run these commands:
	__3.  A common requirement is to change the endpoint URL of a web service import. Modify the endpoint URL of  ACMEImport as follows.
	__4.  Verify that the change has taken place by running:
	__5.  Change the endpoint URL back to the original value:
	__6.  Save and exit.
	__7.  Close the command prompt window.
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	Lab 12 -  Clustering ESB
	Part 1 -  Architecture
	__1.  Pair up with a fellow student, preferably someone next to you.  Collectively, your two machines will form the basis of the cluster.
	Currently, each of you should have an identical deployment environment; the local machine will keep its configuration and federate a new  node that will be added to the remote machine.
	__2.  Nominate one of you to be the local machine and the other to be the remote machine.  Keep this distinction straight amongst yourselves as you proceed throughout these labs!
	__3.  Find and record the IP address of the local machine.  If you are not sure how to do this, ask your instructor.
	__4.  Stop the DM and server instance running on both nodes.

	Part 2 -  Install the Load Balancer – IHS
	__1.  Shut down any open firewall(s) that may be running on the machine.  Typically, Windows has its software firewall running, and it will need to be disabled.
	__2.  Launch launchpad.exe (from C:\Software\WAS ND v61\Supplement).
	__3.  In the right pane, click the link for Launch the installation wizard for IBM HTTP Server.
	The IBM HTTP Server V6.1.0.0 installer screen will appear.
	__4.  Click Next.
	__5.  Select I accept both the IBM and the non-IBM terms and click Next.
	__6.  Click Next.
	__7.  Change it to C:\IBM\HTTPServer
	__8.  Click Next.
	__9.  Leave the defaults (80 and 8008) and click Next.
	The Windows Service Definition screen will appear. 
	__10.  Set the Password to wasadmin
	__11.  Click Next.
	__12.  Uncheck the box Create a user ID for IBM HTTP administration server authentication.
	__13.  Click Next.
	__14.  Accept the defaults and click Next.
	__15.  Click Next.
	__16.  Click Finish.
	The web server has been installed.  The next step is to associate this server instance with our cell.
	__17.  Close the installer launch pad. 
	__18.  Start the deployment manager.  (Remember, this should all be done on the local machine)
	__19.  Start the node agent if it is not already running.
	__20.  Login to the DM console.
	__21.  In the left pane, expand Servers and click Web Servers. 
	__22.  In the right pane, click New.
	__23.  Enter mywebserver for the Server name.
	__24.  Click Next.
	__25.  Click Next.
	__26.  Set the Web server installation location to C:\IBM\HTTPServer
	__27.  Set the Plug-in installation location to C:\IBM\HTTPServer\Plugins
	__28.  Click Next.
	__29.  Click Finish.
	__30.  Click Save.
	__31.  Wait for synchronization and click OK.
	__32.  Check the box for mywebserver and click Generate Plug-in.
	__33.  Check the box for mywebserver and click Propagate Plug-in.
	__34.  Open file C:\IBM\HTTPServer\conf\httpd.conf with a text editor.
	__35.  Locate the last line in the file, where the WebSpherePluginConfig setting is located. 
	__36.  Change it to 
	C:\IBM\HTTPServer\Plugins\config\mywebserver\plugin-cfg.xml
	__37.  Save and close the file.
	__38.  Switch back to the admin console.  
	__39.  In the table of web servers, check the box next to mywebserver and click the Start button.  
	The server's status should change to the green arrow.
	__40.  Start the server MyTopology.AppTarget.WAxxxxNode01.0 on the local machine. Wait until it has started.
	__41.  Open a browser and navigate to:

	Part 3 -  Create the New Node
	__1.  Shut down any open firewall(s) that may be running on the machine.  Typically, Windows has its software firewall running, and it will need to be disabled.
	__2.  Stop all servers that are running.  This means the deployment manager, the node agent, and the server. 
	__3.  Launch pmt.bat from folder C:\IBM\WebSphere\ESB\bin\ProfileManagement.
	This will launch the Profile Management Tool. 
	__4.  The Welcome to the Profile Management tool window will appear.  Click Next.
	__5.  Select WebSphere Enterprise Service Bus.
	__6.  Click Next.
	The Profile Type Selection screen will appear. 
	__7.  Select Custom profile.
	__8.  Click Next.
	__9.  Select Advanced profile creation and click Next.
	__10.  Set the Profile name to Clustered01
	__11.  Set the Profile directory to C:\IBM\WebSphere\ESB\profiles\Clustered01
	__12.  Click Next.
	__13.  Accept the defaults and click Next.
	__14.  Set the Deployment manager host name or IP address field to the IP address of the local machine.   
	__15.  Set the User name and Password to wasadmin. (This is the administrative username and password for the deployment manager on the local machine)
	__16.  Click Next.
	__17.  Accept the defaults and click Next.
	__18.  Change the drop down to DB2 Universal.
	__19.  Click Next.
	__20.  Click Create.  
	__21.  Uncheck the box marked Launch the First steps console and click Finish.
	__22.  Close all open windows.

	Part 4 -  Create A New Clustered Server
	__1.  Login to the admin console, if you are not already logged in.
	__2.  In the left pane, expand Servers and click Clusters.  
	__3.  Click MyTopology.AppTarget
	__4.  Click the Cluster members link.
	__5.  Click the New button.
	__6.  Set the Member name to be MyTopology.AppTarget.<remote_node_name>.0
	This is a bit of an awkward name, but we choose it be consistent with the existing member's name, which was chosen by WESB when we created the deployment environment. 
	__7.  In the Select node drop down box, select the node that you created on the remote machine.  This means that the member being created will be run on the specified node (remote machine).
	__8.  Click Add Member.
	__9.  Click Next.
	__10.  On the Summary screen, click Finish.
	__11.  Click Save.
	__12.  Wait for synchronization and click OK.
	We have successfully defined a new cluster member. member. 
	__13.  Start the newly added member.  (To do this, check the box next to the member, and click the Start button).
	__14.  In the left pane, expand Servers and click Web Servers.  
	__15.  Generate and then propagate the plug-in as you did earlier in this lab.
	__16.  Logout of the admin console.
	Our cluster is complete! 

	Part 5 -  Test the Cluster
	__1.  Open a browser, and browse to 
	__2.  Test the application; enter some sample data and make sure you see the Account Created success message.
	We should first determine which server is being forwarded to.  Fortunately for us, our application peforms some logging; every time the register operation is invoked, some text is printed to the log file.  Knowing this, we can use the pigtail program to examine both log files to figure out which server is being used.
	__3.  On the local machine , open the  <CSTM_PROFILE_ROOT>\logs\<servername>\SystemOut.log file using Notepad.
	__4.  Go to the bottom of the file and verify the message is received.
	__5.  Close the log file.
	__6.  On the local machine, launch the pigtail program, from C:\LabFiles
	__7.  From the menu, select File | Open and navigate to <CSTM_PROFILE_ROOT>\logs\<servername>\SystemOut.log
	__8.  In the application browser that you just used, go back and enter a new registration.
	__9.  Go to the pigtal and you will get the message. This is the logfile for our local cluster member.  You may see text like the following.
	__10.  On the remote machine, launch C:\LabFiles\pigtail
	__11.  From the menu, select File | Open and navigate to C:\IBM\WebSphere\ESB\profiles\Clustered01\logs\<membername>\SystemOut.log
	__12.  In the browser of the local machine, click Refresh. (If prompted, click Retry)
	__13.  Do this a few times.  You should see that all the requests seem to be going back to the same server instance.  Why is that?  Simple: by default, the IHS plug-in uses server affinity (e.g always sends request back to the same server).
	__14.  Using the admin console. shut down the cluster member that is receiving all the requests.  To do this, login to the admin console. Expand Servers in the left pane, and click Application servers underneath it.  In the Application servers table on the right, select check the box for the member that is receiving the requests and click Stop.  Click OK when prompted to stop the server.
	__15.  When the server is stopped, wait a few seconds and then try registering again.  
	__16.  Flipping the servers.  This means take down the server that is currently running, and bring up the server that you just stopped.  
	__17.  Hit the registration application again.  It should still be fine. 
	__18.  Start both servers. Make sure they are both running before continuing.

	Part 6 -  The Clustered Web Service
	__1.  On either local or remote machine (or both!) start WebSphere Integration Developer (WID) using the same workspace.  
	__2.  The RoutingExample project should still be open in the Projects pane.  Expand Web Service Ports underneath it. 
	__3.  Right-click on AccountingMediationExport_GenericAccountingHttpPort and select Web Services | Test with Web Services Explorer.
	__4.  In the Navigator pane of the WSE, select WSDL Main.
	__5.  In the right pane, under WSDL URL, enter 
	__6.  Click Go.
	__7.  Click the addCustomerToSystem link.
	__8.  For each parameter (name, streetAddress1, etc), click the Add link, and enter some sample data into the field.
	__9.  Make the country field either USA or Canada.
	__10.  Click the Go button.  This will invoke the service. 
	__11.  Click Go a few more times.  All the requests should go back to the same server instance.  
	__12.  Let us now test the clustering aspect.  Shut down the server that is responding to the requests.  
	__13.  Click Go in the WSE again.  Check the pigtail window in the server that is still running.   You should see the usual log statements!
	Failover is working!  It looks like our cluster is indeed working and our mediation flow has been successfully clustered.
	Congratulations!  You have successfully built and tested a WebSphere Enterpise Service Bus cluster! 
	__14.  Start the server that you stopped.
	__15.  In WID close all open windows.
	__16.  Close WID.
	__17.  Close the pigtails in both machines.
	__18.  Logout the admin console.
	__19.  Close all open browsers.
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